
File Manager Jr.
For Version 6.0 of Microsoft® Word for Windows™

File Manager Jr. comes in a smaller package than the Windows File Manager but 
performs many of the same functions.  Only faster.

Using File Manager Jr., you can quickly delete and rename files without having 
to switch to the Windows File Manager. You can also open existing files, move 
and copy files, delete all BAK files in a single pass and print documents without 
having to open them. You can recover deleted files (if you have MS-DOS 6 or 
6.2), and you can create, rename and delete directories.

By default, the main Word directory is the master directory.  Using the default 
setup, you can store and access files in the main Word directory and in four levels
of subdirectories below the main directory.  If you don’t want to use the default 
setup, you can designate any directory on any hard drive as the master directory.  
You can then store and access files in that directory and its subdirectories.

Conventions used in this guide
Names of File Manager Jr. commands appear in boldface.  Names of files and 
directories appear in small capitals.  Words to be typed by the user appear in 
small bold capitals.  Section titles are boldfaced when cited in the text.

Command buttons in dialog boxes may be referred to simply as “commands.”  

In keyboard instructions, the plus sign and the space have shorthand meanings 
when used between names of keys.  A plus sign (as in “Alt+S”) means that the 
first key is to be held down while the second key is pressed.  A space (as in “Tab 
B”) means that the first key is to be pressed and released before the second key is 
pressed.

Running the program
To make it easy to start File Manager Jr., you should assign the program to a 
shortcut key and/or toolbar button.  (Step-by-step directions are found on pages 
13 and 14.)
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When the program starts, you see the main menu.  One column of commands 
appears on the left and another on the right.  An open panel appears at the center 
of the menu.  This panel is called the Directory box.

If you select a command in the left-hand column, a list of directories appears in 
the Directory box (as illustrated below).  You can then choose the directory in 
which you want to carry out the command you have selected.

Commands in the right-hand column are enclosed in a free-standing box and 
operate independently, making no use of the Directory box.  If you choose a 
command button on the right, the specified command starts running immediately.
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Examples of common operations

Mouse   To open a file in C:\WINWORD\REPORTS, first click the Open button on 
the left side of the main menu.  Then double-click the name REPORTS in the 
Directory box.  A file list appears.  Choose a filename.

To open a file in a subdirectory of C:\WINWORD\REPORTS, first click the Open  
button.  Then single-click the name REPORTS in the Directory box and click the 
elongated button labeled Sub.  A subdirectory list appears.  Double-click a 
subdirectory name.  Or, if you want to drop down another directory level, single-
click a subdirectory name and then click the Sub button.

Note   Because of its extended length, the Sub button is always within easy reach 
when needed.  After selecting a name anywhere in the Directory box, you can get 
to the Sub button by moving the mouse pointer only slightly to the left.

To move, copy, delete, rename or print a file, first click the appropriate command
button.  Then choose a filename just as you would if you were opening a file.

Keyboard   To open a file in C:\WINWORD\MEMOS, first select the Open button 
by typing the letter O.  Then highlight the name MEMOS in the Directory box and 
press Enter.  A file list appears.  Highlight a filename and press Enter.

To open a file in a subdirectory of C:\WINWORD\MEMOS, first select the Open 
button.  Then highlight the name MEMOS in the Directory box and choose the Sub
button by pressing Tab S or Alt+S.  A subdirectory list appears.  Highlight a 
subdirectory name and press Enter.  Or, if you want to drop down another 
directory level, highlight a subdirectory name and then choose the Sub button.

Tip   When you need to go down one or more directory levels to access a file, you
may find the mouse easier to use than the keyboard.

To move, copy, delete, rename or print a file, first press a letter key to select the 
appropriate command button.  Then choose a filename just as you would if you 
were opening a file.

General   When you select a command in the left-hand column, the program 
assembles a list of your document directories and displays the list in the Directory
box.  If you have many directories, it may take a moment for the list to appear.

If you select a command in the left-hand column and discover that you picked the
wrong button, you can reselect.  Example: If you intend to select Delete but 
select Undelete by mistake, just click Delete.  Or press Tab D or Alt+D.  

If you want to restart the program, choose the Home button.  To choose Home 
using the keyboard, press Tab H or Alt+H.

When you choose the Sub button to display a subdirectory list, a Back button 
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appears in the group of controls below the Directory box.  If you choose the Sub 
button by mistake, you can use the Back button to go back one step.  To choose 
the Back button using the keyboard, press Tab B or Alt+B.

Note    Back buttons appear in many File Manager Jr. dialog boxes.  Generally, 
choosing a Back button closes a dialog box and redisplays the previous dialog 
box.

To run one of the commands in the column on the right side of the main menu, 
simply click a button or press a letter key.  Example: To run the Back Up 
command, click the Back Up button or press the B key.

To access a file in drive A or drive B, select a command in the left-hand column 
and then choose a drive button.  To choose the drive A button using the keyboard,
press Tab V or Alt+V.  To choose the drive B button, press Tab E or Alt+E.

A button labeled DRIVE X appears below the DRIVE A button.  The function of 
DRIVE X is explained later.   

Note    For brevity, most step-by-step examples found later in this guide omit 
keyboard directions.  Such directions appear only when procedures used to 
perform a keyboard operation have not been covered by earlier examples.

The master directory
Unless you tell the program otherwise, the main Word directory will be the 
master directory.  If C:\WINWORD is the master directory, you can store and access
files in  four levels of C:\WINWORD subdirectories.  Examples: C:\WINWORD\
ARTICLES, C:\WINWORD\ARTICLES\COMPUTER,  C:\WINWORD\ARTICLES\
COMPUTER\APPS,  C:\WINWORD\ARTICLES\COMPUTER\APPS\WORDPROC.

If you don’t want to use the main Word directory as the master directory, choose 
the Setup button on the main menu and then choose the Master Directory  
button.   In the next box, type the name of the directory you want to use as the 
master directory.  The directory can be on any hard drive.  If you have a D drive 
and you make D:\WORDDOCS the master directory, you can store and access files 
in four levels of D:\WORDDOCS subdirectories.  Examples:  D:\WORDDOCS\
ARTICLES, D:\WORDDOCS\ARTICLES\COMPUTER,  D:\WORDDOCS\ARTICLES\
COMPUTER\APPS, D:\WORDDOCS\ARTICLES\COMPUTER\APPS\WORDPROC.

Tip   Though you can work with files in subdirectories as many as four levels 
below the master directory, you may find it advisable to use multilevel directories
sparingly.  The more levels you have to deal with, the longer it takes to access 
files, regardless of the method used.
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The command list
Open   The command opens a previously saved file.

Without opening any documents, you can use the Open command to get 
information about files.  Example: To see which files are stored in C:\WINWORD\
MEMOS, select the Open button and then double-click the name MEMOS in the 
Directory box.  After checking the file list, click Cancel or press the Esc key to 
close the Open File box.

Move   The command transfers a file from one directory to another.  It can also 
be used to move a file to or from a disk in a floppy drive.

Once you’ve chosen the file to be moved, the program displays a list box labeled 
Destination.  To move a file to a directory called REPORTS, double-click the name 
REPORTS in the Destination box.

To move a file to a subdirectory, first single-click a directory name in the 
Destination box.  Then click the elongated Sub button just to the left of the 
directory list box.  A list of subdirectories appears.

To move a file to drive A or drive B, click the appropriate drive button in the 
lower part of the Destination box. 

Copy   The command creates a duplicate of a file and sends the duplicate to a 
destination of your choice, leaving the original copy of the file in place.  The 
command works much like Move.

Delete   The command erases a file.

Undelete   The command recovers erased files, using the Undelete for Windows
program in MS-DOS 6.0 or 6.2.

Procedure: Select the Undelete button and then choose the name of a directory or
subdirectory just as you would if you were using one of the commands described 
earlier.  When the Microsoft Undelete window appears, click one or more 
filenames and then click the Undelete icon.  To close the window, choose Exit on 
the File menu.

To tell DOS what level of file protection you want to use, choose the Undelete 
icon from the Microsoft Tools group in the Windows Program Manager.

Kill BAKs   The command erases BAK files in a specified directory.  Example: If
you want to delete BAK files in C:\WINWORD\REPORTS, select the Kill BAKs 
button and then double-click the name REPORTS in the Directory box.  In the next 
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box, choose OK.  Option: To delete BAK files in the REPORTS directory and in all 
subdirectories of the REPORTS directory, choose the Kill All button instead of the 
OK button.

You can use the command to delete BAK files in all your document directories, 
including subdirectories.  First select the Kill BAKs button and then double-click 
the name of the master directory.  In the next box, choose the Kill All button.

Before using Kill BAKs, close any open BAK files.

The command does not delete BAK files on floppy disks.  When you select the 
Kill BAKs button, the DRIVE A and DRIVE B buttons are dimmed and inaccessible.

Rename   The command changes the name of a file.  When asked to enter a new
name for a document, do not type a directory name or subdirectory name ahead of
the filename.  Example: Don’t type C:\WINWORD\MEMOS\BAKER.DOC.  Just type
BAKER.DOC.  (If you type a filename with no extension, a .DOC extension is 
added automatically.)

Print File   The command allows you to print Word documents without opening 
them.  After choosing a file to print, you’re asked whether you want to print one 
copy of the complete file.  If you answer Yes, printing starts.  If you answer No, a
new box appears so that you can tell Word to print multiple copies or only certain
pages.   

Save New   The command is used to specify where a file will be stored when 
saved for the first time.  Example: If you have a new file onscreen and want to 
store it in C:\WINWORD\REPORTS, select the Save New button and then double-
click the name REPORTS in the Directory box.  When asked to enter a name for the
new file, do not type a directory name ahead of the filename.  Example:  If you’re
naming the file DOCK.DOC and storing it in C:\WINWORD\REPORTS, don’t type C:\
WINWORD\REPORTS\DOCK.DOC.  Just type DOCK.DOC.  (If you type a filename 
with no extension, a .DOC extension is added automatically.)

The command cannot be used to store a new file on a floppy disk.  When you 
select Save New, the DRIVE A and DRIVE B buttons are dimmed and inaccessible.

Get Stats   The command displays statistical information about files in a 
specified directory.  Example: You’re working on a file in the PERSONAL 
directory.  The file DOCK.DOC is in the REPORTS directory.  You want to know the
size of DOCK.DOC and the date it was last saved.  Procedure:  Select the Get Stats
button.  Double-click the name REPORTS in the Directory box.  A Find File box 
appears, listing all files in the REPORTS directory.  Highlight the filename 
DOCK.DOC to display statistical information about that file.  If you want 
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information about a second file, highlight another filename.  When finished, press
Esc to close the Find File box.

You can also get statistical information about files stored in a subdirectory.  Just 
select the Get Stats button and then choose a subdirectory as you would if you 
were using one of the commands described earlier.

Back Up   The command sends a copy of the active document to a backup disk 
in the A drive.  Any previous backup copy is overwritten.

If you want to use the B drive for backups instead of the A drive, choose the 
Setup button on the main menu.  Then choose the Backup Drive button.

Note that Back Up is the first command in the right-hand column on the main 
menu.  Like other commands in that column, it is independent of the Directory 
box.  To back up a file, simply click the Back Up button or press the B key.

Print Selection   The command prints a selected block of text.  First highlight 
the text you want to print.  Then choose the Print Selection button.  (The 
selected block of text must be at least two characters long.)

Find File   The command helps you locate a file when you can’t remember 
where you stored it or can’t remember its name.

When you choose Find File, you’re asked whether you want to search for a 
filename or for text.  If you know the name of the file you’re looking for, choose 
the Filename button.  Type a name in the next box and choose OK.  If you don’t 
know the name of the file you’re looking for, choose the Text button.  An input 
box appears.  Type a word or phrase that is likely to be found only in the file 
you’re looking for.  Then choose OK.  (Some earlier versions of File Manager Jr. 
required the user to place quotation marks around the text entered in the input 
box.  Quotation marks are no longer used.)

If the file is found, you’re informed of its location.

File Info   The command displays a word count, a page count and other 
statistical information about the active document.

Directory Mgr.   The command is used to create, rename and delete directories. 
For additional information, see More about Directory Mgr. later in this guide.
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Address List   The command places an inside address in a business letter.  The 
address is copied from a file in which you store names and addresses.  The 
command is also used to print envelopes, to create address listings, to delete 
listings and to browse and sort the address file.  For additional information, see 
More about Address List later in this guide.

Junk Closet   The command is used to store text temporarily in a holding file 
or to retrieve text from the holding file.  For additional information, see More 
about Junk Closet later in this guide.

Quit Word   The command closes any open files and quits Word for Windows.  
Use the command when you want to make a quick exit.  If any open documents 
have been changed since they were last saved, the changes are preserved.

If you have entered text in a new document but have not yet named the document,
you’ll be asked to supply a name before quitting Word.

Drive X:  A rest home for old files
If you have a spare hard drive, you can use it for storage of old files—files you 
don’t want to delete but would like to move out of your document directories.  A 
File Manager Jr. feature called DRIVE X  lets you conserve space on your primary 
hard drive by transferring old files to a secondary hard drive.

DRIVE X  is a wild-card name.  It can stand for any spare hard drive.  Before you 
can use the DRIVE X feature, you need to identify the spare drive and indicate 
where on that drive you want to store your old documents.

Procedure: Choose the Setup button on the main menu and then choose the  
Drive X button.  In the next box, type a drive identifier and a directory name.  
Example: Typing D:\OLDFILES will tell the program that the D drive is DRIVE X 
and that old documents are to be stored in the OLDFILES directory on D.

You can use the Move command to transfer old files to DRIVE X.  Example: If 
you want to transfer a file from the C:\WINWORD\PERSONAL directory, select the 
Move button and then double-click the name PERSONAL in the Directory box.  In 
the next box, double-click the name of the file you want to move.  A Destination 
box appears.  Click the DRIVE X button.

Note    You can open, copy, rename, print, delete (and then undelete) files in the 
DRIVE X directory.  Example: If you want to open an old file, select the Open 
button and then click the DRIVE X button in the lower part of the main menu.
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More about Directory Mgr.
To create a directory, choose the Directory Mgr. button and then choose the 
Create button.  The name of the master document directory appears in an input 
box.  The name is followed by a backslash.  Type a directory name immediately 
after the backslash and choose OK.  Example: If C:\WINWORD\ appears in the 
box and you add REPORTS, the directory C:\WINWORD\REPORTS is created.

You can use the Create command to create a directory and a subdirectory at the 
same time.  Example: You want to create a directory called C:\WINWORD\
JOURNAL and a subdirectory called C:\WINWORD\JOURNAL\JULY.  When C:\
WINWORD\ appears in the input box, type JOURNAL\JULY after the backslash, so 
that the full line reads C:\WINWORD\JOURNAL\JULY.  Then choose OK.  (If the 
directory  C:\WINWORD\JOURNAL already exists, only the JULY subdirectory is 
created.)

Note    MS-DOS disallows certain characters in directory names.  File Manager 
Jr. disallows the following additional characters: the percent sign, the 
parentheses, the caret (^), the ampersand (&), the braces ( { } ) and the swung dash
(~).

To rename or delete a directory, first close any open files in that directory.  Then 
run the Rename or Delete command.  Follow the onscreen directions.

You can’t use Rename to shift a directory from one level to another.  Example: 
C:\WINWORD\JOURNAL cannot be renamed C:\WINWORD\PERSONAL\JOURNAL.  
That would entail moving JOURNAL to a different directory level.  Nor can you 
use Rename to move a directory from one drive to another.  Example: C:\
WINWORD\NOTES cannot be renamed D:\DOCS\NOTES.

When you rename or delete a directory, File Manager Jr. makes a call to the 
Microsoft Windows File Manager.  The Windows File Manager screen appears 
briefly while the directory is being renamed or deleted.

More about Address List
When you choose the Address List button, you see a dialog box with six 
command buttons.  The first button is Copy Address.

The Copy Address command places an address block in a business letter, saving 
you the trouble of typing an inside address.  The block is copied from a file in 
which you can store frequently used addresses.  The file is called NAMELIST.FMJ.  
It was placed in Word’s home directory when you installed File Manager Jr.

To copy an address block, first place the insertion point anywhere on the top line 
of the body of your letter.  Then run Address List and choose Copy Address.  In
the next box, type a name listed in your address file.  Example: If you’re writing 
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to Horatio D. Blunt, type HORATIO or BLUNT.  Option:  Instead of typing a first 
or last name, you can  type a company name, street name, city name or any other 
combination of characters known to be in the address block you want to copy.

The style you use for letters does not have to match the style used to set up your 
address list in the NAMELIST.FMJ file.  If the styles are different, address blocks  
copied from NAMELIST.FMJ are converted to the style you use for letters.

The second command in the Address List dialog box is Print Envelope.  If you 
have a business letter onscreen, you can use one of Word’s commands (Envelopes
and Labels) to copy the delivery address from the letter to an envelope.  That 
command won’t help you, however, if you’re mailing material without a cover 
letter or sending a letter with no address block at the top.  Solution: If the 
recipient’s name is in your address file, you can still print an envelope quickly.  
First choose the Address List button and then choose Print Envelope.  In the 
next box, type a name or any other combination of characters known to be in the 
address block you want to copy to an envelope.

By default, the Print Envelope command uses the Courier typeface and does not 
print a return address on your envelopes.  You can override these defaults.  
Procedure:  On the main menu, choose the Setup button.  In the Setup box, 
choose Envelope Format.  Select a font and a point size.  When asked whether 
you want a return address printed, choose the Yes or No button.  If you choose 
Yes, Word will use whatever address it finds in your Mailing Address box.  To 
see what’s in that box, choose Options on the Tools menu and click the User Info 
tab.

The third command in the Address List dialog box is Add Listing.  Use it to 
create listings and add them to the address file.  When you choose Add Listing, 
an address box appears.  You type information in the box. A filled-in address box 
might look something like this:

You must type information in at least four fields:  LastName, FirstName, 
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Address1 (or Address2), and CityStateZip.  The remaining fields are optional.

After filling in one field, press Enter to move to the next field.  If you try to move
to the next field by pressing Tab, the cursor disappears and the OK button is 
highlighted.  If that happens, you can return quickly to the address fields by 
clicking the Tab Override button or by pressing Tab T or Alt+T.

If you want to use an abbreviation such as “M.D.,” “Esq.” or “Jr.” in an 
addressee’s name, place the abbreviation in the LastName field—after the 
surname.  See the LastName field in the address listing illustrated on the previous
page.

If you want to use a courtesy title such as “Ms.” or “Mr.,” place the title at the 
start of the FirstName field.  In the Horatio Blunt listing, for example, “Mr. 
Horatio D.” could have been typed in the FirstName field in place of “Horatio 
D.”

If a listing includes a Salutation field, the text entered in that field is used as part 
of a salutation when the listing is copied to a letter.  The Horatio Blunt listing 
would be copied in this form:

Horatio D. Blunt Jr.
President, Blunt Instruments Ltd.
1234 Fifth Street
24th Floor
San Lardo, California 90000-0000
Dear Mr. Blunt:

If “Horatio” had been typed in the Salutation field instead of “Mr. Blunt,” the 
address would be copied with a “Dear Horatio:” salutation instead of a “Dear Mr. 
Blunt:” salutation.

The Phone&Misc field is used to store numbers and miscellaneous information.  
The field normally accommodates two full lines of text.  Note, however, that you 
can use no more than 255 characters in an entire address listing.  You may not be 
able to enter two full lines in the Phone&Misc field if some earlier fields are 
unusually long.  Ordinarily, the 255-character limit should present no problem.

If you’re using both lines of the Phone&Misc field, you don’t need to press Enter 
when you reach the end of the first line.  Just continue typing.  The cursor wraps 
to the second line automatically.  

To save a listing, click the OK button or press Tab and then Enter.  If you try to 
save a listing from which a required field has been omitted, an error message 
appears.  In that case, choose OK to redisplay the incomplete listing.  You can 
then fill in the missing field.

Note   The asterisk is a reserved character and may not be used in any field of an 
address listing.
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The fourth command in the Address List dialog box is Delete Listing.  Use it 
when you want to erase an address.  Directions appear onscreen.

The fifth command is Edit/Browse.  Use it when you want to open the address 
file to get information, correct typing errors or just look around.  When you 
choose the Edit/Browse button, you’re asked where you want to start in the 
address file.  Choose a letter.  The command searches for the first listing under 
that letter.  Example: If you want to look up Horatio Blunt’s fax number or 
correct a spelling error in his address listing, choose B.  You can start at the top of
the address file by choosing A or pressing Enter.

To quit the address file, choose Close on the File menu.  If you have made 
corrections in the file, answer Yes when asked whether to save changes.  

You may notice that listings in the address file do not look exactly as they did 
when you created them with the Add Listing command. The Horatio Blunt 
listing, for example, would look like this:

Blunt Jr.*Horatio D. 
President, Blunt Instruments Ltd.
1234 Fifth Street
24th Floor
San Lardo, California 90000-0000
Mr. Blunt[+]
805-000-0000. Fax 111-1111. Home 222-2222. CompuServe 33333,333.  
Stanford grad. Wife: Sylvia.

Notice that the LastName and FirstName fields are now on the same line and are 
separated by an asterisk.  Notice also that a bracketed plus sign appears at the end 
of the Salutation field.  Do not reverse the positions of  the LastName and 
FirstName fields while editing the address file, and don’t remove any asterisks or 
bracketed plus signs.  (Address listings created with some earlier versions of File 
Manager Jr. contain no bracketed characters but are still usable without 
modification.)

Note    Two blank lines have been placed at the top of the address file.  They 
should not be removed.  Several fictitious address listings have been entered in 
the file for illustrative purposes.  They may be deleted.

The last command in the Address List dialog box is Sort List.  It puts address 
listings in alphabetic order.  When you create listings using the Add Listing 
command, the new listings are placed at the end of the address file.  If you like, 
you can leave them there.  It’s not necessary to sort the address list before using 
the Copy Address or Print Envelope command.  But a sorted list is easier to 
work with when you’re browsing.

More about Junk Closet
The Junk Closet command is used for storage of text you want to remove from 
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the active file but keep available for possible use later.

To store text in the junk closet, first select the text.  Choose the Junk Closet 
button and then choose Store Selection.  The text is sent to a file called 
JUNK.FMJ.  The file was placed in Word’s home directory when you installed File 
Manager Jr.

To find text in the junk file, choose the Junk Closet button and then choose the 
Open Closet button.  A Find dialog box appears.  Type a word or phrase peculiar
to the block of text you’re looking for.  Then press Enter.  If the junk file is small 
and you don’t need to run a search, press Esc to close the Find box.

To retrieve a block of text from the junk file, first select the text and place it on 
the Windows Clipboard.  Then close the junk file and copy the text from the 
Clipboard to the active file.

When you open the junk file, text in that file is displayed in whatever style you’re
using in the active document.  Result: You won’t need to apply your current style
to text imported from the junk closet.  The style will already have been applied.

A separator mark appears before each block of text stored in the junk file so that 
you can easily tell where one block ends and the next begins.

To delete text from the junk file, first run Junk Closet and choose Open Closet.  
Highlight the text you want to erase and press the Delete key.  Then choose Close
on the File menu and answer Yes when asked whether to save changes.

Assigning File Manager Jr. to a shortcut key
1. On the Tools menu, choose Customize.

2. In the Customize dialog box, click the Keyboard tab (at the upper right).   

3. In the Categories list box, click Macros.

4. In the Macros list box (to the right of Categories), click the name FileMgrJr.

5. Click the box labeled Press New Shortcut Key.  Press a key or combination of
keys.  Example: If you want File Manager Jr. to start when you hold down
Ctrl and strike J (for “Junior”), press the Ctrl key and, without releasing it,
press J.

6. Choose Assign.

7. Choose Close.

Note   When File Manager Jr. is installed, it is assigned to a special shortcut key 
(Alt+Ctrl+Shift+Backspace).  That key performs an internal function and should not 
be removed.  It won’t interfere with your own File Manager Jr. shortcut key.

Assigning File Manager Jr. to a toolbar button
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· On the Tools menu, choose Customize.

· In the Customize dialog box, click the Toolbars tab (at the upper left).

· In the Categories list box, click Macros.

· In the Macros box (to the right of Categories), click the name FileMgrJr. and 
keep the left mouse button depressed.  A rectangular outline appears.  
Drag the outline to a position on the toolbar and release the mouse button.

· In the box labeled Text Button Name, type a short name, such as JR.

· Choose Assign.

· Choose Close.

·

Starting File Manager Jr. automatically
If you want the File Manager Jr. menu to appear whenever you start Word, 
choose the Setup button on the main menu.  In the Setup box, choose 
AutoMenu.  Follow the onscreen directions.

Uninstalling File Manager Jr.
1. In Word’s home directory, delete JUNK.FMJ, LICENSE.FMJ, NAMELIST.FMJ, 

READ_1ST.TXT and TUTOR.FMJ.

2. In the directory where Word templates are stored, delete FMJ.DOT. 

3. On the Tools menu, choose Macro.  In the macro list box, delete all macros 
with “FileMgrJr” in their names.
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Registration information
File Manager Jr. is a shareware program.  You’re required to register the program
if you continue to use it after a 30-day trial period.  You can become a registered 
user by paying a fee of $15 to the author, Charles Maher, 409 North 18th Street, 
Coeur d’Alene, Idaho 83814-5460. 

If you have a MasterCard or Visa account, you can call toll-free to register.  To 
register by voice phone, call 1-800-215-3688 between 6 a.m. and 3 p.m. Pacific 
time.  If you have a modem, you can use a 24-hour number: 1-800-503-2292.  
Indicate that you are registering a product developed by vendor 3864.

You can also register on CompuServe.  Type GO SWREG. The Registration ID for
File Manager Jr. is 5059.
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